
CS211 Lecture: The User Interface

Last revised November 19, 2008
Objectives:
1. To introduce the broad field of user interface design
2. To introduce the concept of User Centered Design
3. To introduce a process for user interface design
4. To introduce key concepts concerning accessibility

 Materials: 
1. Lethbridge/Langanere description of British Midlands flight 92 and USS 

Vincennes incident
2. User account for “aardvark” on my Mac set up to use Simple Finder
3. Lethbridge/Langaniere ppt slides for §7.4
4. Projectable of Braude figures 3.21-3.24
5. “Why bother with Accessibility” from “Accessibility and the Swing Set” 

(http://java.sun.com/products/jfc/tsc/articles/accessibility/index.html)
6. Video store project to demonstrate accessibility

I. Introduction

A. At the outset of our discussion, it is important to again note what we 
discussed at the start of the course about different kinds of stakeholders in 
a software project.  Recall that a stakeholder is anyone who has a 
legitimate stake in the outcome of a project.  

1. For a typical software project, there are four kinds of stakeholders.  
Who are they?
ASK
a) Users - those who will eventually use the software.

b) Clients - those who decide to have the software developed, and pay 
for doing so.

c) Developers - those who actually produce the software.

d) Development managers - those who oversee the work of the 
developers.

2. A common mistake in software projects is to consider the needs of the 
clients, but not the needs of the users who will use the software.  (An 
even worse mistake is to ignore both in favor of the needs of the 
developers!)
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B. There is a growing awareness in the software industry of the need to very 
consciously think about the eventual users of the software - i.e. not just the 
client who is paying for it, but the people who will actually use if (who 
may be employees or customers of the client.)  This leads to a key concept 
called User-Centered Design.

1. One key notion in UCD is involving users in the design process.

2. Another key notion is bearing in mind user characteristics in the design 
process.  What are the kinds of things we should bear in mind 
concerning potential users of a software system?
ASK

a) Their goals - why are they using the software?
b) Their demographics - what is their age, education, language and 

culture, etc?
c) What is their knowledge of the software domain?  (Employees of a 

client are typically more knowledgeable in this regard than 
customers - but not necessarily if the software is controlling a 
complex system.)

d) What is their knowledge of using computers?
e) What is their physical ability?   Designing software systems to be 

easily usable by people with physical handicaps is important:
(1) Visual handicaps, including blindness, need for large fonts, color 

blindness.
(2) Hearing handicaps
(3) Need for alternatives to using a mouse

C. Another key idea in UCD is the notion of a use case.  

1. As you recall, use cases are structured in terms of user goals - i.e. the 
are potential answers you would get if you asked a system user “what 
are you trying accomplish?”

2. In developing a system incrementally, it is good practice to first focus 
on the “central” use cases - i.e. the ones that represent the reason why 
the system exists - i.e. the ones that users will need most often.

Note that we did this for the course project - renting and returning 
items are clearly the central cases for a video rental store.  (We 
included the item status report to make initial testing possible
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D. One of the most important factors in determining the success of many 
software systems is the quality of its user interface - the way in which 
human users interact with the program.   

1. This may be:
a) A command-line interface.
b) A graphical-user interface
c) A special hardware interface (e.g. for an embedded system, such as 

our ATM example.)
d) In some cases, of course, the user interface may seem not to be an 

issue at all, because the program does not interact with users 
directly (e.g. network protocol software that interacts only with 
other software).  Even so, there is typically some kind of user 
interface involved for adjusting parameters, etc, and the 
functionality of the software eventually impacts the functionality of 
the software that users do interact with.

2. The quality of the user interface impacts a program’s success in at least 
two ways.

a) Users prefer (and will purchase) programs that have a user interface 
that they perceive as best meeting their needs.

b) In some cases, human safety or even lives may be at stake - poorly-
designed UI’s have led, in some cases, to people dying.  Examples?
ASK

(1) British Midlands flight 92 - READ DESCRIPTION FROM page 
258 in Lethbridge/Langaniere

(2) Shooting down of an Iranian passenger plane by the USS 
Vincennes  - READ DESCRIPTION FROM page 281 in 
Lethbridge/Langaniere

E. In this lecture, I want to deal briefly with three issues:

1. Fundamental concepts of user interface design

2. The process of designing a user interface

3. Considerations for making a user interface accessible to individuals 
with sight, hearing, or physical handicaps.
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II. Fundamental Concepts of UI Design

A. The topic of UI design is a huge one.

1. A focus of graduate-level programs, including PhD in CS programs

2. A broad field, encompassing several fields in addition to CS, including

a) Psychology

b) Library/Information Science

c) Education

d) Communications

e) Technical Writing / English

f) Art

3. A classic work in the field: Shneiderman, Ben.  Designing the User 
Interface.  (3rd ed, 1998: Addison Wesley)

4. I certainly wouldn’t claim much expertise in this area.

B. One key concept is recognizing that a good UI has two properties which 
can conflict with one another: Usability and Utility

1. Definitions

a) Usability has to do with the ease of using the software.

b) Utility has to do with the functionality of the UI - what can the user 
do with the software?

2. What are some key aspects of usability?

ASK

a) Learnability - including provision for both novice and expert users

b) Efficiency of use (not the efficiency of the software - but the 
amount of work a user must go through to use the software in 
terms of selecting options, responding to modal dialogues, etc.)
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c) Effectiveness of error prevention / detection / correction

d) Acceptability - do users like to use the system? 

3. Why are usability and utililty sometimes in conflict with one another?

ASK

4. How might this be addressed without compromising one or the other?

ASK

a) One approach is to provide different modes of operation (e.g. 
“novice mode” and “expert mode”) 

Example: demonstrate Simple Finder in Mac OS (user “aardvark”)

b) Another is to provide different ways of performing the same 
function (e.g. making it possible to select a given function via a 
menu, a toolbar, or a hot key)

Example: You have seen this in NetBeans

c) The software may include a help facility accessible via a help facility 
that has hot links to 

Example: Demo Mac Help “Set Date” - then follow link to open 
date and time preferences 

C. In general, a UI is easier to learn if it follows established conventions.

1. Menu structures generally follow certain conventions that are so well 
established that we almost take them for granted, for example:

a) Most applications have a File menu as their first menu.  This is the 
standard way of specifying file-related operations, including print 
and quit.   (Even if there is nothing else that makes sense in a file 
menu, quit is still normally there.)

b) Likewise, most applications have an Edit menu as their second 
menu.

(1) If it is meaningful to let the user undo an action, that will 
normally be the first option in the Edit menu.
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(2) If it is meaningful to include “cut and paste” in the UI, then the 
Edit menu with these options is needed.

c) Many applications include a Help menu, which is generally the last 
menu.

d) Normally, the program should display just one window on the 
screen (to avoid confusing the user).  The exception would be a 
“document-centric” program that lets the user work on multiple 
documents at once - in which case the program will typically have 
one window per document, and a Window menu that includes the 
option of selecting different windows.  Traditionally, this comes just 
before the Help menu.

e) Other examples?

ASK

2. Often, menus will have keyboard shortcuts.  There are certain 
traditions related to these - e.g. the shortcut “S” is normally used for 
Save, “O” for open, “W” for close, “C” for copy, “V” for paste, 
“X” for cut, and “Z” for undo.

3. Adhering to standard structures like these wherever possible makes 
learning a new program much easier!

D. In the world of UI design, there are some key terms which you should be 
familiar with 

1. Dialogue (as distinct from “dialog box”)
The interaction between the user and the system

2. Control or “widget”
A visible UI component - menu, button, etc.

3. Affordance
The set of operations the user can do at a given point in time.  UI 
designers would say “A button affords clicking”

4. State
At any given point in time, what the user sees and can do (the set of 
widgets and the affordance at some point in the dialogue)
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5. Mode, modal dialog

A state in which the affordance is restricted to a limited set of options.  
A modal dialog is a dialog box that requires a user to “satisfy” it 
before doing anything else.  As a general rule, modes and modal 
dialogs should be minimized, but are sometimes useful.

a) Example: ASK

“File save” and “Print” dialogs are often modal - once the user has 
decided to save or print a file, it makes little sense to allow further 
changes until the action is complete.

b) Note that modal dialog boxes often have a “Cancel” to allow the 
user to get out of the mode without actually doing anything.

6. Feedback

The response from the system to an action performed by the user 

7. Encoding Technique

The way information is presented to a user - can be audibly, visually, 
or both

a) Note that great care needs to be used in selecting encoding 
techniques to allow for physical handicaps, to preserve privacy, and 
to avoid annoying users.

b) Where possible, it is desirable to encode key information in more 
than one way to accomodate diverse needs.

E. Finally, we should note that there are many principles of good UI design.

1. Question “i” from book

2. One text gives 12 usability principles, plus an illustration of using them 
to improve a defective GUI.  

PROJECT/GO-OVER Lethbridge/Langaniere powerpoints for §7.4

3. Another writer gives a more pointed set, and another illustration.

PROJECT/GO-OVER Braude figures 3.21-3.24
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III. The Process of Designing a User Interface

A. This will not be an attempt to give a detailed process for designing a UI.  
Rather, we will note some tools that can be helpful

B. A good starting place for the design of a UI is the use case model for the 
system. 

1. Obviously, the UI must make provision for each use case

2. If the use cases are simple, it may be desirable to associate either a 
button or a menu option with each use case.

Note: Some operations - such as opening, saving, or creating a file - are 
traditionally done using options in the File menu.  Other operations 
may be better associated with buttons

3. Often, a tool bar tool may also be provided to initiate a frequently-used 
use case - in addition to a menu option or button.

4. If the use cases involve more complex operations, it makes sense to 
allocate a screen (or series of screens) to each.  In this case, a button or 
menu option is typically used to initiate the operation.

5. Often, it is meaningful to group use cases into groups of closely-related 
operations, which then might have a common starting point (e.g. 
individual panes within a tabbed pane.)

C. Often, a statechart can be used as a design tool.

1. Each state would correspond to a single screen - or perhaps a state of a 
screen (e.g. with certain operations enabled and others not.)

2. Transitions between states correspond to user actions such as clicking a 
button.

The UI should be designed so that state transitions that would lead to 
problems are not possible.

3. You have already done some work representing a GUI using a 
statechart on your project.
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IV. Accessibility

A. With a bit of forethought, it is possible to ensure that the user interface for 
a given program is accessible to users with widely varying physical 
abilities.

B. This also turns out to be an important consideration for legal and 
marketability reasons.
READ From “Why bother with accessibility?” in “Accessibility and the 
Swing Set”

C. Some things one can do to promote accessibility.

1. Frankly, this is a very big topic that I’m only beginning to learn about.

2. Modern operating systems often incorporate facilities to facilitate 
accessibility.  I will use Universal Access in Mac OS as an example 
because I am most familiar with it, but Windows and the Linux Gnome 
project have similar capabilities.
Walk through Universal Access System Preference on Mac, discussing 
each capability

3. However, it is important for software to be developed to facilitate using 
this kind of support support

D. Many people depend on keyboard navigation via the tab and arrow keys 
instead of point and click with a mouse, for either visual reasons or due to 
inability to manipulate a mouse.
DEMONSTRATE tabbing in the VideoStore project - rent details.  Note 
how only enabled components are included.

1. Tabbing through components is tied to the concept of keyboard focus.  
The component that has the keyboard focus is the one that receives 
keyboard input.  (This is why you may have to select a text field in 
order to type in it.)

a) Each window displayed on the screen can have a component that is 
the focus owner for that window.

b) At any given time, there is only one window that is the focussed 
(front) window, and its focus owner is the focus owner for the 
whole system.
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c) However, it is possible for a window not to have a focus owner.  In 
that case, when that window is the front window no component has 
the keyboard focus.

2. Within any given window, a “focus cycle” is the sequence of 
components that receive the focus as one tabs around a window.  

a) In Java Swing, a default focus cycle is established for a container, 
typically based on the order in which components are displayed 
(e.g. the default focus cycle for a container with a BorderLayout is 
top, left, center, right, bottom)

b) It is also possible to customize the focus cycle for container.

3. One thing that is very important is to ensure that the focus is always 
owned by some component in each window.  
In the case of whose contents can change (like the tabbed pane used 
for the Video Store project), it is important that focus be given to some 
component in a given pane when that pane is made the visiible one.  
(This is ccomplished by requestFocus() in the formComponentShown() 
method - which should actually be requestFocusInWindow()!)

4. When a window has many focusable components, it may be desirable 
to use panels within the window to create groupings, each with its own 
focus cycle.  In this case, the overall focus cycle for the window 
involves the individual panels, and one can go down into the focus 
cycle of the individual panels.

E. Assistive technologies exist to convert visual displays into spoken text 
(screen readers) or braille.  For these to succeed, components need to be 
able to furnish information about themselves to the assistive device. 

1. Assistive technologies depend on the notion of screen focus, making 
information available about the component that currently has focus.  
(Hence, if no component has the focus at some point in time, the 
assistive technology is useless.)

2. In Java swing, this is handled through accessibility properties.
(SHOW in NetBeans)

a) AccessibleName - often defaulted (e.g. text displayed by a Button)

b) AccessibleDescription - defaults when there is a tool tip or there is 
an associated JLabel whose labelFor property is set.
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3. Of course, this is important with other software systems as well.  For 
example, when using images in a web page, one can include an alt tag 
that provides a textual description of the image.

F. When designing a UI, it is important to facilitate access by assistive 
technologies:

1. Ensuring focus is always set.

2. Avoiding use of encodings for which there are no alternatives.  
(Example: if color is used to encode information, then the same 
information should also be accessible via a textual description; if sound 
is used to encode information, then there should be an available 
alternative such as a screen flash or text.

3. Ensuring that information can be accessed/entered using mouse 
alternatives such as tabbing.  (Standard Swing components in Java 
support this, but if one creates custom components one may need to 
take steps to ensure this.)

11


